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Introduction

Photoshop is one of the premier graphic software packages used by 
many photographers. Here you will find an introduction on what the 
Adobe graphic software is about and how you can use it for your proj-
ects. You will be able to learn the secrets that can help you master this 
software so that your projects will appeal to others.

Photoshop is not one of those software programs where you can easily 
start on your own. You may want to take your time while using it be-
cause you don’t want to go too fast while learning the ropes. You will 
learn how to add images, and other tips that you need to know in order 
to become a professional in graphics.

There are so many things to do with this graphic software, but it’s im-
portant to know the basics first before you start diving into more ad-
vanced features and functions. When you learn to do one thing, you 
can move on to other tasks.

In order to get started, you must open the Photoshop software. You 
will see the Photoshop desktop. Within the desktop, you will find the 
following categories: title bar, menu bar, options bar, status bar, toolbox, 
image window and palettes.
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Within the title bar, you will see the name of the software, along with the 
most recent name of the file (if there is one). Each time a file is created, 
the extension will end with “.psd”.

The menu bar will have different commands to use for your file, such 
as edit, image, layer, select, view). There are other commands, but the 
commands mentioned are some of the ones that are used most often. 
You will find the options bar above the menus.

The toolbox bar has tools that are used for images that are in the graph-
ics software. You can only use one tool at a time. In order to activate 
it, you must click on the corresponding icon. These tools are used for 
many of the Photoshop projects. Here are some brief details on the 
ones that most people use:

1. Hand – Dragged in order to move an image around.
2. Move – To move a certain area, you must click and drag.
3. Zoom – Zoom in and out by clicking or dragging.
4. Crop – To do this, you must click and drag that certain area; 

to execute the crop, press Enter; to cancel the crop, use  
the Escape key.

5. Marquee – The selected images will be clicked and drug
6. Type – Using the type tool, click the image where you want 

to include type.
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7. Brush – Used for painting brush strokes.
8. Eraser – Gets rids of areas that have solid colors.
9. Dodge – This tool is used for to lighten any picture wherever 

you select it.
10. Burn – This tool is used to make certain areas 

on your image darker.
11. Wand – This tool is used for colored areas. You can use it to 

select, erase, color or adjust.

At one point or another, you will use these tools from the toolbox bar. 
They can help you when you’re creating images, designs or other draw-
ings. The more you use them, the easier it will be for you to utilize them 
when the time comes. They can help to enhance the beauty of your 
work.
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PALETTES

You can use palettes to do different things with Photoshop. You can 
show or hide certain ones by going to the window menu and selecting 
a palette name. Palettes are placed into different groups.

For instance, one group would consist of layers, channels and paths. If 
you need to move a palette group, you can do so by dragging the blue 
bar that is located at the top of the group. If you want to shrink a palette 
group, click on the blue bar twice. Using the close box (“X”), you can 
hide a palette group if you wish.

The palettes have tabs and they can be moved around by dragging 
them. If you don’t want to do that, then the palettes can be mixed into 
other groups. Or if you want to place them in a default setting, you can 
do that also.

This graphics software also has rulers that you can use to see the mea-
surements of your image. You will be able to tell whether it’s too big or 
too small. If you want to change the size, click on the ruler twice, or you 
can use the “Preferences” command. You can change the measure-
ment from pixels to inches.

Using the status bar, you will have information regarding the current file 
that you’re working on. You will be able to view and use one of the tools. 
The status bar shows which tool that you have chosen to work with.
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USING IMAGES

How To Get Images Into Photoshop

You will need to have an image in order to create a file. There are several ways that
this can be done.

1. If there is a file that already has an image, then click File, Open or File and then Browse. Most files that have  
images will open in Photoshop.

2. Create a new file. Click File and then New. Choose a name for the new file and go to the Preset menu 
and enter the information requested.

3. Scan an image from a computer into Photoshop by clicking File and then Import.
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How To Move An Image Around

You can move an image around in Photoshop when you are in the editing stage. In fact, you will be able to multi-task as you zoom 
in and go around it. As you’re editing, you can zoom in and out to see what you need to do as far as adjustments are concerned. 
In order to do this, you should use the zoom and hand tools, and also the palette that is used for navigating.

Click or drag the image using the zoom tool. The more your zoom in, the more the image size will increase and get larger. You 
will be able to see how much the image has increased by looking at the status bar. If you want to see it in its entirety, click on the 
zoom icon twice. Use the ALT key to get out of the zoom function.

The hand tool is used to go around the image while you are still zoomed in. You can drag the hand in order to do this. If you want 
to move the image using the Navigation function, click Window and Show Navigator. If you want to see more than one window of 
an image, click Window, Arrange and New Window. This setup will help you to get in close up to an image, or at least part of it.
You will also be able to see another window while you are looking at the first image.
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Size of Image, Resolution and Print Size

You will probably want to know more about sizes of images, resolution and print size. You can do that by using the dialog box for 
Image Sizing. In Photoshop, you need to open an image. Select Image, Image Size and you’ll see the dialog box.

Pixels or picture elements make up digital images. There is only one color in each pixel. The number of pixels in an image has to 
do with width and height. This also correlates with how large or how small you can see the display on the computer screen.
In the “Document Size” function, using width and height allude to how large or small the image will be when you print it.
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Printing Images

When you want to print an image in a larger size, you should decrease 
the resolution. If you need to change the size of an image before you 
print, make sure that the “Resampling Image” box is not checked. While 
increasing the size, the resolution will decrease if you increase the width 
and height. If you do the opposite of this, then the result will be the 
opposite.

If you’re printing an image for leisure use, using a resolution of 72 ppi 
can work. However, if it is more on the line of newspapers and newslet-
ters, you will need increased resolutions starting at 150 to 200 ppi. For 
magazines, the resolutions would be higher, from 250 ppi on up.

Scanning Images In Photoshop

The image should be in the scanner, face down on the glass. Pho-
toshop will need to be opened. Select “Import”, then Twain Acquire.” 
Photoshop has scanning software that will open up to be used.

Choose the resolution for your image. There is a certain dpi (dots per 
image) you will need. Here are some suggestions for how you should 
set the dpi:

1. If you are enlarging prints, you should use dpi starting at 300 
or more.
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2. With general 1 to 1 printing, you should use dpi at 300.
3. For projects that use PowerPoint or the internet, you should 

use dpi at 72.

Select preview and wait for the scanner to get to the scan in preview 
format. Choose the selection tool to look at an area to scan in the pre-
view. You will probably need to adjust settings afterwards. Select the 
tool icon and choose either photo or drawing. This will help your image 
to look clearer and have a better contrast.

If you have other changes, such as color, balance, brightness, etc., do 
them only once the image has been scanned and imported to Photo-
shop. You have more flexibility to make changes and other adjustments 
in Photoshop than you would with the software used for scanning.

In order to do this, choose the scan function and you will see “untitled 
document” in the image. Using Photoshop, you can change the size of 
it. Choose the edit menu and select “Image Size”. If the graphics take 
up a lot of space, they can take quite of bit of time to load on a dial up 
modem.

So if this is your predicament, you would want to have a thumbnail size 
of the image. This size would be much smaller than the image you’re 
trying to resize, and would take up less space. When you create the first 
image in Photoshop, you will need to save it. Then create the thumbnail 
size. You would create these images from the scan.
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When it’s time to save the file, there are several suffix formats you can 
use. If the image is a photo and being used for the internet, use the .jpg 
suffix. If the image is not a photo and being used for the internet, use 
the .gif suffix.

If the images come from the printer and they are of high quality, you can 
use .tiff or .jpg. There is more information involved when you save an im-
age using .tiff. However, it comes without additional layers like .psd im-
ages have. You would only save the image to .psd if it contained layers.

Save the file where you can easily locate it later on. It may be helpful to 
create a folder and save it for images only.

Editing Images

You can do quite a bit with images when you use Photoshop. The 
graphics software has plenty of components and tools that can help 
with editing images. Here are some basic things that you should know 
when you are doing that:

Make sure that you have two images when you’re creating them. The 
initial image should be used as a backup and have another copy that 
you can work on. This is good to do in the event you don’t like the way 
the image looks or you messed up. At least you will be able to start over. 
You can also choose to use the file prior to when you made changes. 
You can do this by selecting File and Revert. Or you can choose the
History palette.
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If you do make some changes to images, only the part that is be-
ing changed is affected. Usually, the changes would include 
the image pixels.

When making changes to an image and there is more than one layer, 
the changes usually only affect the newest layer.

Rotating Images

This is when you want to turn an image any way that you want when 
you’re using Photoshop. In the graphics software, open the image that 
you wish to rotate. Then click the rotate command located in the Image 
menu. Select how much you want to turn the image by using the de-
grees of rotation.

If you have a certain number, choose Free and put in the number, then 
choose Ok.

When you save the file, use a different name. Check the image and if 
you don’t like it, you can change it. Go to the Edit menu and choose 
undo to reverse what you did.

Saving A Photoshop Image

You can be irritated trying to look for a saved file, only finding out that 
it’s not where you thought it was. That’s nothing compared to what 
you would feel if you created a Photoshop file only to save it in the 
wrong format. There are certain things that you can do in order to 
make sure that your Photoshop files are saved the correct way.

1. Here is the way you can save an image file in Photoshop:
2. Select File, Save; or you can use the Ctrl  

and the S key together.
3. Create a name for the file in the file name area.

Using the dropdown menu, get a file location. You can use a drive 
or a folder to do this. Select the file format that you will save it in. You 
should flatten the files prior to saving them. The saving process will 
work better that way. Or if your image file has layers, you can use the 
PDF format in Photoshop.

Any additional options that you want you can include in the Save 
portion. Go ahead and proceed to save the file.
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Layers

Layers are used in Photoshop images. The background layer is usu-
ally the only layer that each image has. You can use layers during the 
image editing process. They can also be used for special effects.

If you make a copy of a layer and then decide to change it, you will 
have the first layer as a backup. You would make changes or adjust-
ments to the copy of the layer. Another thing that you can do with 
layers is put images together by using different content.

With the exception of adjustment layers, for the most part, layers are 
required to have quite a bit of memory. The larger files from Photo-
shop usually contain a lot of layers. To use the layers, go to the Lay-
ers palette from the Window menu.

In the first column of the palette, you will see some layers on the 
computer screen. You will be able to identify them by the eye icon. 
Even though you will be able to see the layer, it may not be totally 
transparent.

This means that you will be able to see any layers that are under the 
initial one. You will notice the transparency when you see a checker-
board pattern. There may be times when you will have to or want to 
change the visibility of a layer.
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If you decide to edit the layer, whatever you change will also affect the 
newest layer. If you want to use another name for the layer, click on 
the layer’s name twice and type the new name. If you want another 
layer to be the new layer, choose that layer in the palette.

If you want to create a new layer, use the icon for creating a new layer 
in the Layer palette. Or you can create a new layer by moving the 
previous layer to the icon for the new layer.

If you want to get rid of a layer, use the trash icon. Or you can move 
the layer to the trash icon.

If you don’t want to make changes or adjustments to a layer, use one 
of the Lock boxes. These are located at the top of the Layers palette. 
In the Lock boxes area, you have commands and components such 
as lock pixels, lock layer position, lock transparent areas and lock all.

Styles

You have different styles to choose from when you have images with 
layers. There are different special effects you can use to enhance 
your image in Photoshop. You would choose the layer in the palette, 
then choose the Effects button. You will see a layer style dialog box. 
This is where you will be able to create the special effects for the layer
that is open.
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When you want to save the effects, you will select “New Style”. You 
can use some of the same effect later for other layers. To do that, 
choose the style in the palette and you will have the same ones to 
use for that layer. To use the Styles palette, select Window, then 
Show Styles.

Parts of layers that you can see through will have edges. You can also 
use effects here. If there are not transparent portion, there’s a chance 
you may not see any changes after the layer effects are applied.

Layers can also be used to put images together. Open two images 
and with the move tool, move one image on top of the other. The 
initial image will look like a new layer in the next image. You can also 
put images together by copying and pasting one image to another 
image. This can also create a new layer.

If you need to edit your images, you can use adjustable layers to do 
that. These layers are not only adjustable and editable, they can be 
used with Levels, Photo Filters, Hue/Saturation and other commands 
as need.

An adjustment layer is created by using the Layer function. Select 
New Adjustment Layer and then select one of the menu compo-
nents. You can choose from Color Balance, Curves, Levels, etc.)
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Or you can choose the adjustment layer button and get the same 
menu of components.

If you need to adjust any settings with this, use the dialog box. With 
the adjustment layer, you can edit any part of it. On the other hand, a 
regular Levels adjustment is not allowed to be totally edited.

The dialog box will be in the adjustment layer and you can adjust any 
settings that you need to. You don’t need a lot of lot of memory and 
the file’s size does not get larger.
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Using Selection Techniques

When you use selection techniques, essentially you are setting apart a 
portion of an image so that you can make changes to it. Or you may 
want to include that portion with other images. That portion is consid-
ered a selection.

With the selection, you can still utilize the tools used to edit images and 
other commands. The selection portion is protected and is considered 
a “mask”. This part of the image is protected in Photoshop. You will see 
an outline of the selection on the screen.

Using a selection tool icon, you can make a selection. Whatever tool 
you will be using will be in the Options bar. Use Windows and Options if 
you don’t see them. You will not see all of the tools right away. You may 
have to click on some tools in order to see the ones that are hidden.
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Use the Ctrl-H function to show and hide the selection outline. Using 
Select, then Inverse will make the selection inverted. If you wish to re-
verse the selection, choose Select>None. To save a selection, choose 
Select, then Save Selection.

If you need to include more on a current selection, use the Shift key. 
To remove from a current selection, use the Alt key. If you need to add 
more to a current selection because of color, choose Select, then Sim-
ilar.

If you need to move a selection or part of it, use the move tool and drag 
it to where you want it.

If you want to feather a selection, use the Feather checkbox. Using this 
will allow your selection to look softer.
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How To Make Your Photos Look Better

Use an image that has a .jpg or .png suffix format. Place the images 
on your computer. Using Photoshop, open the photo. Make a copy of 
the background layer. Using the copy, you will need to use “Overlay” or 
“Soft Light”.

Go to the Filters section and select Other and High Pass. This will get 
you to the High Pass Filter. Choose an edge and adjust the radius to a 
different sharpness. The usual sharpness is between 1.0 and 3.5.

Go to Layers, New Adjustment Layer and Levels. Select Options where 
you will see three buttons. Test all three buttons to find which one will 
provide you with the best colors for your image.

Go to Layers, New Adjustment Layer and Curves to set the image’s 
contrast. To form the shape of the letter S, click about ¼ of the line 
upward and pull the image down just slightly. Then go about ¾ up the 
line and pull up slightly.

Make new layers on top of everything shown. Use the Overlay com-
mand and the brush tool. Change the colors back to black and white. 
The flow should be around 30%. Set the hardness at 0% in the brushes 
palette. Paint the selected areas that you want to draw attention to in 
white and black.
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Colors

Using different colors in Photoshop is part of the creation process. When using colors you are considered to be in color 
mode. Photoshop does have a default where there are certain colors that most if not all people use. The color scheme is 
called RGB or Red, Green, Blue. In fact, this is the main legend that is used in Photoshop.

The color modes are used to use the colors that are included in each color image pixel. If you need to adjust the color 
modes, then click Image and Mode.

Each set of modes consists of channels with a grayscale image. These images can have as many as 256 shades that in-
clude white and black colors. You can look at the channels by clicking Window and then ‘Channels. The channels can be 
edited and adjusted if need be. Doing this can help to improve the way some of the images look.
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There are some color modes that are used more than others. Here are 
some of the ones that are used the most:

1. RGB Mode – Red, Green and Blue; used to edit and adjust 
images in color.

2. Grayscale Mode – A gray color setting that has 256 shades 
and only uses one channel.

3. Indexed Mode – Only uses one channel for color and can 
hold up to 256 color values; it is also used for photos that 
have the .gif extension.

4. Bitmap Mode – Used for black and white colors only.

5. CMYK Mode – Four colors, Cyan, Magenta, Yellow and 
Black; this method is used for professional publications. 
They should be kept and saved in this mode.
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Adding Colors in Photoshop

With the variety of colors that Photoshop has, there is no excuse as to 
why your project won’t come out looking nice. It is not difficult to add 
colors in Photoshop. In fact, adding color to a strictly black and white 
photo will not only make it look different, but it will also
bring the quality of the photo up a notch or two.

Use a black and white image that is already in the graphic software. You 
can drag the picture file on your desktop and place it on the Photoshop 
icon. After releasing the left mouse button, the software will open and 
show the picture where the file was. Or you can open the software and 
allow the program to come up. Once Photoshop is opened, click the 
File command. Then click open and look for the file that you need to 
open.

In the toolbox section, choose the Polygonal Lasso tool on the left side 
of the Photoshop menu. Click on it to change the mouse arrow to the 
lasso tool. The lasso tool should be pointed on a top corner of the pic-
ture. Choose the black and white picture using the lasso tool by holding 
down the left side at the top of the mouse. You will drag the selection 
lines until they are wrapped around the picture. When the picture
is surrounded by the lines, you can edit it the way you want it.



24

Go to the Adjustments command by selecting it from the Image drop 
down list. Choose hue/saturation by clicking on it. This is what you will 
need to use in order to add color to the picture. Use the scrollbar until 
you get it the way you want it. As you are making changes, you will be 
able to see them in the preview area.

Color Correction

If you need to correct the colors on your images in Photoshop, you can 
use the Auto Color and Photo Filters. Both of these are simple to imple-
ment and can make your images look better than they did previously.

When using Auto Color in Photoshop, you are correcting images with 
color by checking the shadows, midtones and highlights. In order to 
do this, select Image, Adjustments and Auto Color. Test it to see how 
your image comes out. You can also get to the Auto Color command 
by going to the Levels dialog box and choosing Options. When you do
it this way, you can use different options, which gives you an advantage.

If you see that the highlights are too much, select the Highlights Clip 
option to tone them down.
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Using Photo Filters is another way to change colors on your images in 
Photoshop. Select Image, Adjustments and Photo Filters. You will see 
photo filter settings inside your image. There is also a preview box and 
you will be able to see how the settings help your image. If you need to 
photo filter to have more effect on your image, use the density setting.

You can also use Hue/Saturation to change the color of your image. 
To get there, you would select Image, Adjustments and Hue/Satura-
tion. With Hue/Saturation, you can change all of the hues at once. You 
would do that by using the color wheel and changing their positions. In 
addition to that, you can use Hue/Saturation to change whether or not 
you want deep colors or lighter colors as far as saturation is concerned.

If you wish to sharpen your image, select Filter, Sharpen and Unsharp 
Mask. You will want to keep the preview box available. This way you will 
be able to see different views of the effects. You should sharpen your 
image no less than 50% and no more than 150% for normal images.

It is not mandatory that you use these guidelines to sharpen your image. 
They are suggestions. All of them may not work for everyone. So the 
best thing for you to do is experiment and find something that you will 
like. The thing with this is to make sure you it is magnified at 100% and 
keep the Preview box while you’re looking at it.
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Painting In Photoshop

Techniques Used In Painting

You can also create or change images in Photoshop with paint brushes 
and colors. The brushes can also be used as a healing brush and to 
erase things that you don’t want or need.

Select Edit, Preferences, and Displays & Cursors in order to adjust the 
display. This will allow you to see the various painting tool sizes while 
you use them for your image. Choose the brush size you need for your 
image.

Select an area that you wish to paint and mark it. You have to do this 
because it prevents the part that is not selected from being painted. 
However, if you decide to paint the whole thing, then nothing should be 
selected.

Black is the default color for the foreground and white is the default col-
or for the background. When you use the paint brushes in Photoshop, 
they will use the current foreground color. To change foreground and 
background colors, you can type the letter X or select the double sided 
arrow. If you want the black and white colors, type the letter D. You can 
also choose a new color by selecting the foreground color from the
tool box.
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Another way to choose colors is by using the swatches palette or the 
color bar. You can also choose the Eyedropper tool. Any of these can 
be use to change the colors to what you want for your image.

Painting Tools

1. Paintbrush – Select the paintbrush picture from the tool-
box. If you need to, use the other options to change the size 
of the paintbrush. Use the drag method for the image or part 
of the image that will be painted. If you want to create straight 
lines, as you’re dragging, hold down the Shift key.

2. Eraser – The eraser gets rid of the background color if the 
process is done on the background layer. There are several 
types of erasers to use from the Eraser tool. You can choose 
pencil, airbrush, paintbrush or block. When you need to 
erase, use the dragging method on the image. It’s a good 
idea to have a copy of your work in the event you acciden-
tally erase something you shouldn’t have.

3. Paint Bucket – The Paint Bucket is used to fill in areas that 
are close to where you have selected pixels. If you don’t 
want to have transparent spots filled, make sure that “Pre-
serve Transparency” is checked. Select the Paint Bucket tool 
and in the Options bar, choose a tolerance value. Select the 
part of the image that will be filled with the Paint Bucket.
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Photoshop Brushes

When using brushes in Photoshop, you can paint and draw on images. 
This is one of the main parts of graphic design with this software. When 
you are learning how to use brushes, the skill is not something that you 
can catch on to overnight. It will take some work and some practice to 
get it the way it’s supposed to be. Once you get the hang of it, using 
the brushes will become a piece of cake.

Using a photo in Photoshop, select Layer from the menu and choose 
New Layer. When you are implementing different elements to each pho-
to, you should always use a new layer. Doing this can make it easier for 
you as far as editing is concerned.

In the main tool menu, select the Brush icon and choose Brush Tool. 
Select the paintbrush icon and choose one of three components (Air-
brush, Paintbrush or Spray Paint). Depending on what effect you want, 
choose Airbrush for a light brush effect, choose Paintbrush for a solid 
brush effect and Spray Paint for a spray paint brush effect.

Choose the brush size you need by selecting Brush Size in the pull 
down menu. You will also need to choose the type of stroke that you 
will use. Choose the style that you want by selecting the Mode menu. A 
good suggestion is to use “Normal” because that is what most people 
use. Photoshop provides plenty of brushes for you to use. However, if 
you need more, there are plenty of websites that offer them.
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In order to determine how dark you want your brushstrokes to be, you 
will need to use the “Opacity” arrow. You will use the sliding control to 
choose between 0 to 100%. There is also a sliding control to determine 
how much flow in regard to using your brushstrokes for color.

In order to use the eyedropper, select the Color Box. You can use the 
color scale until you get the color that you want. To use the color with 
your brush, use the left click on your mouse. When you need to add 
another element, you will need to add a new layer. See how it looks and 
if you don’t like it, you can always delete the layer.
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Pictures In Photoshop

Picture Layout – How To Use It

Implementing the picture layout is simple and doesn’t take a lot of time. You can put images together or change the way the 
picture looks. Make sure that your layout is already in place if you are putting pictures together. Here are some steps to take in
order to make your picture layout look professional.

1. Open two photo files in Photoshop.

2. Select the Marquee tool and choose the part of the picture that will be copied. Using the paste function, 
place the first picture on top of the other one.

3. Select the Edit function in the Copy menu. You will copy the area.

4. Use the Paste function and choose the second photo. Part of the first photo should be placed on top of the 
second photo.

5. Using the Magnifier, zoom into the portion of the photo that is pasted.

6. In order to move the images around, use the hand tool. During this time, your file is still in the zoom phase.

7. If you need to make adjustments to the photo that is pasted, select the move tool.
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Cropping Pictures In Photoshop

When you are cropping part of a picture, that usually signals that you 
don’t want that part to be there. It may be a portion of something that 
should not be there, or something that you just don’t care to see. So, 
you will attempt to crop or cut it off. When you do that, what is left is 
what you want on the picture. Here are some steps you can take to get 
rid of portions that you don’t want.

1. After you’ve opened the graphics software, find the image 
that you want to change.

2. Choose the crop tool which is located in the Photoshop tool-
box.

3. Go to one of the corners to where you want to crop off the 
image and start there.

4. Drag the image down until you have what you want to crop.

Using the resizing handles, adjust the area that is to be cropped. You 
can also do this by clicking and dragging the selection. Whatever is 
outside of the square will be cropped, while the remaining part of the 
image will stay.
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Select the green check mark that is located at the top of the screen in 
the toolbar. This will signal that you are giving permission for that area 
to be cropped. After the action has taken place, you will only have the 
portion that you opted to keep.

Using Picture Effects

If you want to make your pictures come alive, using picture effects in 
Photoshop can help you do just that. Using this component of Photo-
shop is simple to do. The only thing that is required of you other than fol-
lowing the directions is that you should have some type of imagination.

Photoshop has plenty of picture effects that you can use and these 
instructions will show you how to apply a double image and make that 
image into something that you may never have thought of.

Open a picture from Photoshop. You will see a layer called “Background”. 
Using the right-click button on your mouse, open it and choose the 
command “Duplicate Layer”.

The actual duplicate layer should be named something else. After you 
have saved the new file, you should see two layers in your layer palette. 
If for some reason the layers palette does not open in Photoshop, select 
“Window” and choose “Layers”. Or you can try using the F7 key at the 
top of your keyboard.
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Using the Move tool, you will find a spot and click on the newly created 
duplicate layer. Drag the picture in whatever direction you choose. Keep 
dragging it and under the duplicate one, you will see the first picture.

Select the “Free Transform” command from the Edit menu. If you need 
to change the second picture into different shapes and sizes, this is 
what you would use to do that.
Doing that would also require using the Move tool in order to get the 
picture to where you want it.



34

Other Features and Special Effects

Adding Text In Photoshop

You can add text to an image or a blank document. The Type tool is what you would use to do that. This tool also works to 
choose an image size, a font and allows you to make additional changes in regard to text. Everytime you make changes 
in regard to text, the image or document will look different. Here’s how you would go about adding
text:

Use an old file from Photoshop or you can create a new one. You will use the Type tool.

Using the first button on the type tool bar, you will be able to change back and forth from horizontal to vertical text and 
vice versa.
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Choose a text size, font and style. You can do this from the Type tool 
options bar.

There are different ways that you can have your text set up. You have 
a choice of choosing from the following styles: Smooth, Strong, Crisp, 
Sharp or None. Each one looks different, so you may want to look at 
them all to see which one looks the best for your creation. When you’re 
aligning your text, you can choose to do it from the left,
center or right.

To use the color picker box, select the color square. You can select the 
color for your text.

You can click the selection anywhere in your document. You will start 
typing your text and it will show with whatever selections you have cho-
sen. If you need to make changes use the Type tool to highlight the text 
already there and change what needs to be changed.

Creating 3-D Effects

3-D or three dimensional effects is something that is unique to create 
for your graphic projects. Using this technique will allow you to see your 
graphics differently.

Using Photoshop is a great way to create 3-D effects and other related 
images. You can start with something as simple as a cube. You want 
the cube to been seen from three different angles, top, left and right. 
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You would then include different effects on the cube to make it stand 
out. Using Photoshop for this technique allows you to use your imagi-
nation and creativity.

Using the 3D Transform is used to create 3-D effects in Photoshop. 
You can also use it to create different images into a 3D shape. If you’re 
just looking for a basic image, then you can choose Select and Direct 
Select. You can move objects with the Select function, while you can 
change the images by dragging with the Direct Select function.

To create shapes in 3-D, you will have to create a new layer. Then you 
can use color to fill in the white space. To step it up a bit, you may want 
to add darker colors or shadows. Using fillers can help you to better see 
the 3-D effects in Photoshop.

You can also create text using 3-D effects in Photoshop. With the Alt 
key, and E/F, and the Ctrl key (hold down), you can use the dragging 
method to do what you wish.

With the text layer, you will need to convert your image to make it look 
presentable for people to see on the monitor prior to you including filters 
or layers. The text will be changed to where you can edit it as needed. 
Prior to completing the conversion, create an extra copy. After the con-
version, you are not allowed to edit any text.

To get different image creations, it is probably a good idea to test out 
some image effects. Create some where you can do 3-D images with 
shapes, text and other effects. 
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Creating A Lighting Effect

Including special effects such as lights to provide some pizzazz to a 
photo can be interesting. You can turn regular lights into some unique 
lighting effects. A lot of people that have substantial experience using 
Photoshop use these effects for their projects. It’s a pretty easy task to 
learn. Here is how you can learn it and create your masterpiece:

Select File, New and then click OK.

Choose the “Gradient” tool and click on the left button of your mouse, 
holding it down.
Choose the “Paint Bucket” tool and choose the color Black.

Click the screen once. The background should turn black. Select the 
Filter component and choose “Render”, then choose Lightning Effects.

Select “Circle of Lights” and choose OK. You will see something called 
objects that look like spheres (orbs).

Choose “Render” from the Filter menu and choose “Lens Flare”. This is 
how you will make changes to your photo. In order to get the light where 
you need it to be, you will have to move the cross in the center of the 
screen. Using the “Brightness” bar, slide it to the middle. Use the “50 to 
300 mm zoom” selection for the lens and select Ok. You will see a lot 
of lighted halo shapes.
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Staying in the Filter menu, choose the “Stylize” command. Choose 
“Glowing Edges”. This is used to decrease thickness of the halos. The 
rings will stand out on the screen. Using the “Image” menu, choose 
Adjustments and then Auto Levels. You will see the halos in the special 
effects on your computer screen.

Creating Backgrounds

You can create different backgrounds for your images. You will have to 
use more than one filter to do this. Using the filters can help to create a 
background that is different than what you may have seen before. You 
can create custom backgrounds that are unique and stand out from 
other creations.

To do this, you would have to select the File menu and choose New for 
a brand new dialog box.

In order to create a canvas, you would have to select the Width and 
Height components. If you have anything you would like to change, 
change them in the settings section. You can change the colors and 
resolutions if you wish.

Close the New dialog box and present the canvas on the computer 
screen. You should see the word “Background” in the layer of the Lay-
ers palette.
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In the “Filter” menu, select “Artistic” and choose on the options for the 
Filter dialog box. You have a choice of filters that you can use for your 
document. There is Artistic, Brush Strokes, Distort, Sketch, Stylize or 
Texture. They are all located in the drop down box where the Filters 
category is.

Select a filter from the category you have chosen. You will be able to 
see a preview of this filter to the left side of the “Filter” dialog box.

Go to the right side of the dialog box if you need to adjust the setting. 
Confirm the filter that you want to use by choosing OK. If you need to 
include additional filters you can do so. This will help you to have addi-
tional custom backgrounds.

Importing And Exporting

Learning about importing and exporting images from Photoshop can 
boost your credibility in creating images from this graphics software. 
Once you learn this, you will be able to do just about anything using 
Photoshop.

If you are going to use an image in a Photoshop file that was already 
created, you can import it and use it as a layer. People that look to have 
several images to put together implement this step. With the original 
image in the background, the other image will be a separate document.
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The new image can be transferred to a layer where it can be adjusted 
or edited. Move the new image over the original document. The new 
image will stay the same, but there will be an additional layer with the 
first image.

If you have an image to import as a layer, you can use the Place com-
mand to do that. Look in the File menu for this command. The image 
would be placed in a Photoshop document. If you have to make adjust-
ments you can save the image to the first file. So, if you make changes 
to the Photoshop file image, the same thing will be done to the
image file.

If you have movie frames that you want to import, you can use the video 
frames to layer command to do that. You will have several choices that 
you can use to import certain parts of the movie. You can also import 
frames in a certain succession. This means that not every single frame 
has to be imported.

Use the shift key and place the slider on the movie clip to get certain 
portions of the movie. The “Limit to frames” component allows you to 
choose frames that you want. You can choose every second, third or 
fourth frame if you wish. It depends on how you want it set up. If you 
don’t choose anything, every frame will be imported.
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Zooming Techniques

Using the zoom tool in Photoshop is a good way to get a close-up look 
at your photo or image. It can also be used when you need to correct 
details. You can also look at your photo or image as a larger or smaller 
view.

Use the zoom tool to start. You will see a magnifying glass with a plus 
sign in it.

Deactivate the Resize Windows to Fit button. When you do this, the 
image window won’t change sizes as you adjust the size of the view.

Activate the Ignore Palettes command. When you do this, the size of the 
window will increase to the screen’s edge.

Position where you want to enlarge the image and select it. Any clicks 
after that will help to enlarge it.

Choose and drag a marquee to the part of the image that will be en-
larged. Press the Alt key in order to decrease the size of the view. Hold 
the key down and continue to click with your mouse until the size of the 
image has decreased to the size that you want it.
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Strokes

People that create images in Photoshop, in particular Photoshop CS3, 
will use strokes. They also use them with text and shapes. Photoshop 
provides different variations of what strokes you can add to your image.

Using Photoshop CS3, select a file that you wish to use to implement 
a stroke with. Choose the layer in which you want to use to apply the 
stroke. You will find this in the Layers palette. When it is chosen, the 
layer will be highlighted.

Using the right click button from your mouse, select “Blending Options”. 
You will see the Layer Style dialog box. In the same box, you will find 
the “Stroke” component in the Styles listing. You will see it on the right 
side of the box.

If you want different stroke settings, you can make changes as follows:

1. Changing the size – move the slider to the right for a larger 
size; move it to the left for a smaller size.

2. Changing position – You have three choices, inside, cen-
ter or outside.

3. Changing fill type – You can choose from color, gradient 
or pattern.



43

You can either choose to change the stroke’s opacity (cloudiness or 
dullness) or implement blend mode. After you’ve selected what you 
wanted, save your settings and close the dialog box. You will see the 
changes in the chosen layer of your image or photo.

Creating A Watermark In Photoshop

Select File, New and create the width and height using 250X125 px. 
You will also need to have a background that is transparent.

Select the “Horizontal Type Tool”, set you color to your choosing and 
type in what you want your watermark image to read.

Using the Ctrl button, also press the letter “T” keys on the text and 
choose the rotate command. With your mouse, go over the image and 
rotate it to what you want.

Select Edit, Define Pattern and give it a sample name since 
it is a sample and not the real thing; you’re testing this technique first to 
make sure it works.
If you have other images or photos that you want to do this with, open 
the file that you want to watermark. Apply a new layer by pressing the 
Ctrl and the letter “J” keys.

Select the Edit and Fill commands. Choose a pattern from the Custom 
Pattern selection box. You can set the layer’ opacity to what you want it 
to be. Save the new image with the watermark.
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Creating A Shadow Effect

Create a new image in Photoshop. As a sample, use 200 pixels and 72 
pixels as the resolution. This is for the width and the height. After you’ve 
created the effect, then you can do more using different settings. You 
want to make sure it comes out right, hence the reason for using 200 
pixels and 72 pixels as the resolution.

Using the Horizontal Type Tool, create a text box. The image that you 
are using should be blank. This can be done by using your cursor at 
the upper left corner, clicking it and using the dragging method to bring 
it to the lower right corner.

Use 48 point font for the text and center it. Choose a simple color and 
put it in the text box several times using the return key. The word “shad-
ow” should be typed in the text box. Place the word in the center of the 
image. Make sure it is showing up large inside of the box. You should 
eventually notice a shadow behind the word.
Using the “Styles and Effects” menu, look for two drop-down menus. 
The one on the left should be “layer styles” and the one on the right 
should be “drop shadows”. Select one of the options for the drop shad-
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ow. Select the “low” shadow and you will see the shadow behind the 
text.

You should test the shadow effect options in Photoshop using different 
styles. Eventually, you will find one that suits you the best. Also, you 
need to make sure that it blends in with whatever images you will be 
using.

The most important thing about using Photoshop overall is to make sure 
that you save whatever you create. At least you’ll have examples that 
you can go back to later.
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Resources

Adobe software:
http://www.adobe.com

About information website:
http://www.about.com

Wikihow:
http://www.wikihow.com

Ehow:
http://www.ehow.com

YouTube: http://www.youtube.com
(plenty of Photoshop tutorial videos)
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